# Table of Contents

## Part I Welcome

## Part II Introduction

1. Getting Started ................................................................. 6
   Installation ........................................................................ 6
   Enter your license key ...................................................... 7
   Populate the data ............................................................ 8

2. User Interface .................................................................. 9

## Part III Reference

1. Menu Bar ......................................................................... 14
   File Menu ........................................................................ 14
   Backup ............................................................................ 14
   Restore ........................................................................... 15
   Exit ................................................................................ 17

   View ................................................................................ 17

   Tools ................................................................................ 18
   Search ............................................................................. 18
   Send Overdue Checkout Reminder .................................... 19
   Manage Selection Fields ................................................. 19
   Manage Loan Agreements .............................................. 20
   Database Connection ....................................................... 21
   Import ............................................................................ 23
   Export ............................................................................. 25
   Database Security .......................................................... 25
   Barcode Reader Setup .................................................... 27
   Options ........................................................................... 27

   Help ................................................................................ 28
   Contents ........................................................................... 29
   Check for updates ........................................................... 29
   Ask a question.................................................................. 29
   About Asset Manager ..................................................... 30

2. Assets ............................................................................. 30
   Assets List View ............................................................... 30
   Asset Form ...................................................................... 32
   General ........................................................................... 33
   Finance ........................................................................... 35
   Service ............................................................................ 37
   Notes and Attachments ................................................... 39
   History ............................................................................ 39

   Check In ........................................................................... 40
   Check Out ........................................................................ 41
   Audit Record .................................................................... 43

3. Personnel ...................................................................... 44
   Personnel List View .......................................................... 44
   Personnel Form ................................................................ 45
   Assets Checked Out........................................................ 47

© 2019 Kaizen Software Solutions
1 Welcome

Welcome to the Asset Manager User Guide

This User Guide is designed to serve both as an introduction and as an on-going reference for the program. If you have just started using Asset Manager, check out the Introduction and Getting Started links below. Experienced users will find more details in the Reference section.

- Introduction
- Getting Started
- Reference
- System Administration
- How To (Steps)

2 Introduction

Asset Manager is an easy-to-use database for tracking company asset records. The interface provides a familiar “Microsoft Outlook” look-and-feel that many users are already comfortable with.

Asset Manager provides a central repository for storing and retrieving your asset records, allowing you to quickly look up information about a specific asset or group of assets. Check-in or check-out assets to personnel by scanning the barcode to bring up the record right away. Asset Manager is designed to work “out of the box” with very little configuration required. The Standard Edition is designed for use on a single workstation, while the Enterprise Edition allows multiple people to share and use the database at the same time.

Two editions are available:

- The **Standard Edition** is designed for use on a single workstation.
- The **Enterprise Edition** allows multiple people to share and use the database at the same time.

Asset Manager is competitively priced and used around the world. A free trial version is available on the website and can be set up in minutes so you can try the full functionality of the software.

How It Works

To get started, asset information is entered into the database or imported from a spreadsheet. Assets can then be “checked-out” to personnel who are the “custodians” of the asset.

Asset Manager can be used with or without a barcode reader. Without a barcode reader, Asset Manager functions as a standard Asset Management database which allows the user to search for assets through the user interface.

Using a barcode reader however allows the user to quickly scan a barcode to open the asset record and check it in or out to an employee.
Asset Manager works with all types of barcode readers that support keyboard emulation (most do) – these are the types of barcode readers that are hooked up to a computer and send keystrokes as if they were typed in. These barcode readers are sometimes referred to as “keyboard wedge” or just “wedge” type scanners.

Asset Manager can be used to print barcode labels on standard label stock through Sheet Feed type printers such as laser or ink jet printers. A variety of built-in label templates are available, or you may define your own custom formats using the specifications of the label stock you will be using.

- An asset history is automatically maintained as assets are audited or checked in or out.
- Reports allow you to print a list of all assets, checked out assets, or Overdue assets.
- Asset Manager also includes a complete Personnel and Vendor database.
- The database may be protected with a password to limit who may view or edit the records.

### Features and Benefits at a Glance

#### Features:
- Track asset information including a picture, description, brand, model, manufacturer, serial numbers and more.
- Include file attachments and notes.
- Check-in and check-out assets to personnel.
- Print barcode labels on sheet feed printers.
- Maintain an electronic service log.

#### Benefits:
- Eliminate time wasted searching for and replacing lost or missing assets.
- Keep track of who has an asset and when it is due for return.
- Ensure all checked-out assets are accounted for when an employee leaves the company.
- Maintain a central repository for service logs, manuals, and instructions.
- Track vendors and contacts.

### Asset Manager Licensing

- Asset Manager licenses may be purchased online with a credit card, bank transfer, or a company purchase order. The license key is delivered via email and unlocks the 10 record limitation of the trial.
- Asset Manager licenses include free minor upgrades for the life of the version and major upgrades for one year. Upgrading is voluntary and not required to continue using the version of the software that has been purchased.
- Support by email is available free for both trial and licensed users (see additional support information in the next section).
- Kaizen Software Solutions also offers upgrades from the Standard Edition to the Enterprise Edition for the difference in price.

<table>
<thead>
<tr>
<th>Product</th>
<th>Number of users</th>
<th>Price (USD)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Manager Standard Edition</td>
<td>Single User Workstation</td>
<td>$399</td>
</tr>
<tr>
<td>Asset Manager Enterprise Edition</td>
<td>Unlimited Users on Network</td>
<td>$799</td>
</tr>
</tbody>
</table>

*Prices in EUR and other currencies based on the exchange rate at the time of purchase.

### Asset Manager Support

© 2019 Kaizen Software Solutions
All Asset Manager support is available free by email. Additional paid support by telephone is not available at this time. This support model allows our customers around the globe to reach an appropriate expert for their specific technical, sales, or customer service question without wading through multiple levels of support and call backs. Support tickets may be submitted through the website at www.kzsoftware.com

See Also

- Getting Started
- User Interface

Advanced users may want to skip ahead to the Reference section.

2.1 Getting Started

Choose from the following topics to get started:

- Installation
- Enter your license key
- Populate the data

Or for experienced users, jump to the Reference section.

2.1.1 Installation

To install from the web:

2. Open/Run the setup file, AssetManagerStandardSetup.exe. or AssetManagerEnterpriseSetup.exe
3. Follow the instructions in the installation wizard to complete the installation.
A shortcut will be created in the Start Menu Folder. Click the Next button to continue.

Leave the checkbox checked to create a desktop icon. Click the Next button to continue.

Click the Install button to begin the installation.

Also note: if your computer does not have the .NET2 framework installed already, the installer will automatically download and install it before continuing.

Click the Finish button and wait a few moments as the software initializes the first time.

To install on a PC without internet access:

1. If the computer doesn't have the .NET 2 Framework installed, download it onto a disk, flash drive, etc. and then install it. To check, you can look at the Add/Remove programs list in Windows and look for an entry "Microsoft .NET Framework 2.0". The .NET Framework can be downloaded at the link below:

   .NET 2

2. After confirming or installing the .NET Framework, install Asset Manager.

3. The setup file can be downloaded to another computer and then copied to a disk, flash drive, etc, by right-clicking on the download link for the Edition you need, and then selecting 'save target as' to download the setup file. Copy this file to the other computer and run the installation wizard.

4. After opening Asset Manager, enter your license key.

2.1.2 Enter your license key

After purchasing a license key, you will need to enter it into the software to unlock the 10 record limitation imposed while in Trial mode.

1. Select the menu item Unlock Trial Mode → Enter License Key.
2. Enter your license key into the License Key form.
3. Press the enter key or click the Ok button to save.
2.1.3 Populating the Data

Data may be entered into the database manually using the data entry forms, or by importing it from .csv files. If you plan to import your data, please see the Import Data section.

Data may be entered in any order as needed; however, it can be helpful when you start out to enter your data in the order described below for a smooth flow, minimizing the back-and-forth jumping from one area of the database to another. Below is a summary of the steps to populate your database. For detailed information about any of the steps, please see the Reference section.

**Step 1: Selection Fields**

Open the menu option Tools --> Manage Selection Fields. Here you can add values for "Status", "Condition", "Job Title", and "Service Type".

If you don't have all of the data now, that's ok. You can always enter it in later, but entering it now will allow you to easily select it when adding Asset and Personnel records in the following steps.

**Step 2: Personnel Groups**

If you have a list of your personnel groups, you may organize the Personnel Group folder list now. Otherwise, you can add them dynamically when adding a new personnel record. To add a new personnel group, click the "New Group" button on the main Personnel tab located on the left just above the personnel group folders.

You can edit the position within the folder hierarchy by right-clicking on a folder and then selecting Edit. Changing the "Parent" group will move the folder up or down within the hierarchy based on your setting.

**Step 3: Personnel**

Next, enter your master list of Personnel on the Personnel tab. Begin a new record by clicking the "New Person" button. Fill in the information and then click "Save and Close" to add the new person to the list.
You can press the F1 key on your keyboard while the Asset form is open to get more detailed information about the fields if needed. The personnel entered in this section will appear in the list of personnel on the Check Out form for an asset.

**Step 4: Vendors**

Add new vendors by clicking the "New Vendor" button on the main Vendors tab. The vendors will appear in the drop-down selection field on the Asset Form - Finance tab.

**Step 5: Assets**

After entering the Selection Field Values, Personnel, and Vendors, you can add Asset records and use the drop-down fields to select from the existing values that you have set up. To add an Asset record, click the "New Asset" button and then fill in the information. You can press the F1 key on your keyboard while the Asset form is open to get more detailed information about the fields if needed.

**Step 6: Report Header and Footer**

To change the default header and footer on reports, select the menu item: Tools --> Options. Click the respective Edit buttons to edit the default header and footer.

**Step 7: Company Logo**

To add your company logo so it will show up on reports, select the menu item: Tools --> Options. On the Options form, select the Company Logo tab and then click the browse button to select your company logo file.

**Step 8: Depreciation**

If you will be using the Depreciation feature, you can set the Fiscal Year End on the Options form - "Depreciation" tab.

### 2.2 User Interface

This section describes the common user interface elements used throughout the program.

**The Main Window**

The Asset Manager window is divided into 4 main areas: the Menu Bar, the Navigation Tabs, The List View, and the Navigation Folders.
The Menu Bar

The menu bar contains the File, View, Tools, and Help menu items.

More information on each of these menu items is available by going to the Reference section here.

The Navigation Tabs

The Navigation tabs allow you to easily switch between the Assets, Personnel, Vendors, and Reports sections.

More information on each of these tabs is available by going to the Reference section here.
The List Views

The list views display the data in a spreadsheet-like view of rows and columns.

- The toolbar just above the list view contains buttons to add/edit/delete records in the list view.
- Records can also be opened by double-clicking on a row or right-clicking on a row and selecting the Edit menu item.
- Sort the data by any of the columns in the list view by clicking on the header for that column. Click again to reverse the sort order.
- Change the order of the columns in the list view by clicking down on a column header and dragging it while holding the mouse button down. Then release the mouse button to drop it in a new location.
- Filter the data displayed in the list view by entering a few characters in the Quick Search box.
- Right-click on the list view and select Show Columns to select which columns are displayed in the list view.

The Navigation Folders

The Asset list view and the Personnel list view both contain navigation folders on the left side of the screen. These folders allow you to organize the data into groups and quickly filter the list by clicking on a folder. You may create new folders by right-clicking on the navigation folder area and selecting the "New" option from the menu. Or, rename an existing folder by right-clicking on the folder and selecting the "Edit" menu option.
Date Fields

The date fields on the data entry forms contain a calendar field to ensure that the date gets entered into the database in the correct format. This field has several features:

- To leave the field blank, uncheck the checkbox at left side of the field (when available).

- To update the entry using the keyboard:
  - Use the left and right arrows on the keyboard to move back and forth within the field.
  - Use the up and down arrows on the keyboard to change the values, or type the values in using the number keys on the keyboard.
  - Use the tab key to exit the date field, moving the cursor to the next field on the form.

- To update the entry using the mouse:
  - Click the down arrow at the right of the field to drop down the calendar and select a new date.
  - Click the left and right buttons to change the month.
  - Click the name of the month displayed at the top of the calendar pop-up to select a different month.
  - Click the year displayed at the top of the calendar pop-up to select a different year.
  - Click the "Today" area near the bottom of the calendar to set the date to Today's date.

Picture Fields

Picture fields allow you to add a picture to a record. This field is available on the Asset and the Personnel forms.
Click the Browse button to select a picture file from your computer. Picture files may be .jpg, .jpeg, .gif, .tif, .bmp, or .png.
You may also add a picture by dragging it from the Windows Explorer window and dropping it in the picture box.
Adding a new picture will overwrite the current picture.
Click the Clear button to remove a picture.

**Attachment Fields**

Attachment fields allow you to add multiple attachments to a record. The file attachments may be of any type, and they will be stored in the database.

Drag and drop files onto the empty space in an Attachment field to add them to the record.
Or you may click the Attachment icon in the toolbar to select a file to add.
Double-click a file in the attachment field to open it.

3 **Reference**

The Reference section provides a detailed explanation of each area of Asset Manager. Click on a link below for details about the item.

- **Menu Bar**
  - File
  - View
  - Tools
  - Help
- **Assets**
  - Assets List View
  - Asset Form
- **Personnel**
  - Personnel List View
  - Personnel Form
- **Vendors**
3.1 **Menu Bar**

The menu bar is located at the top of the main window. Click on any of the menu items listed below for more information.

**Menu Bar Items**

- **File**
- **View**
- **Tools**
- **Help**

### 3.1.1 File Menu

The **File** menu contains the menu items listed below. Click on a link below for complete details.

**File Menu Items**

- **Backup**
- **Restore**
- **Exit**

#### 3.1.1.1 Backup

The Backup function creates a compressed data file containing a full backup of the database. This feature allows you to create a backup manually at any time. If you are using the Enterprise Edition, you may also schedule an automatic backup.

![Backup Database Dialog](image)

**Steps to backup a database**

- Select a location for the backup file:
- Click **Backup**
- Click **Cancel**
1. Select **File → Backup** to open the Backup database dialog box.
2. Click the Browse button to select a location for the file, and enter the name of the file to save.
3. Click the "Backup" button to perform the backup.
4. Dismiss the confirmation box. If the Backup operation fails for any reason, close the application and then reopen it and perform the Backup operation again.

**Key Points:**

- The backup file is a compressed snapshot of the database. It cannot be opened directly. To restore the database from the backup file, use the menu option: **File → Restore**.
- Be sure to store the backup file on an external or remote drive so it will be available in case your hard drive crashes and becomes inaccessible. If possible, copy the file to a network server that is backed up.
- If you are using the Enterprise Edition with a remote database server, ask your server administrator to schedule a nightly backup using these instructions.
- It's a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.

**3.1.1.2 Restore**

The Restore function restores the data from a compressed backup file over an existing database. This operation will completely overwrite the current database with the contents of the backup file.

To ensure a successful restore operation, it is important that no one else is using the database and no one attempts to log into the database during the restore operation.
Steps to restore a database

1. Select **File → Restore** to open the Restore database dialog box.
2. Click the Browse button and select a backup file that you have created earlier.
3. Click the Restore button and click "Yes" when asked if you want to proceed.
4. Wait while the database is restored. This may take several minutes for a large database. Do not interrupt the Restore operation, or the restored database may be corrupt.
5. Dismiss the confirmation box. If the restore operation fails for any reason, close the application and then reopen it and perform the Restore operation again.

Key Points

- It is critical that no one else is logged into the database or attempts to login to the database while the restore process is running.
- The restore process may take several minutes to complete, and it should not be interrupted.
- The restore process will completely overwrite the database with the contents of the backup file. Any data entered since the backup file was created will be overwritten.
- It’s a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.
3.1.1.3 Exit

Select File → Exit to close the application. This has the same effect as clicking the 'X' in the upper right corner.

3.1.2 View

Select any of the styles in the View menu to change the application window colors. Examples of the different styles available are shown below:

- Sparkle - Blue
- Office 2007 - Blue (default)
- Office 2007 - Silver
- Office 2007 - Black
3.1.3 Tools

The Tools menu contains the menu items listed below. Click a link below for complete details.

Tools Menu Items

- Search
- Send Overdue Checkout Reminder
- Manage Selection Fields
- Manage Loan Agreements
- Database Connection
- Import
- Export
- Database Security
- Barcode Reader Setup
- Options

3.1.3.1 Search

Use the search form to search for Assets, Personnel, and Vendors in the database.
3.1.3.2 Send Overdue Checkout Reminder

The **Send Overdue Checkout Reminder** menu option will open your default email client with the following information pre-populated:

- **To**: a list of all personnel who have an item checked out and overdue.
- **Message**: a list of all Overdue items with the Due Date and name of the person they are checked out to.

If Asset Manager is unable to open your email client, you may need to configure your default email client on your computer. For more information about this, please see the following link: [How to set your default email client](#).

Note: you may need to restart Asset Manager after making changes to your default email client.

3.1.3.3 Manage Selection Fields

The **Manage Selection Fields** menu opens the dialog box which allows you to add, edit, delete, and reorder the selection field values.

[Screencast: Manage Selection Field Values](#)
Manage selection fields and values

Steps to add/edit/delete selection values

1. Select **Tools → Manage Selection Fields** to open the dialog box.
2. Select a Selection Field from the list on the left.
3. Use the buttons on the right to add, edit, delete, or reorder the selection values.

3.1.3.4 Manage Loan Agreements

The **Manage Loan Agreements** menu opens the dialog box which allows you to add, edit, and delete the Loan Agreements which appear on the Check Out form when checking out an asset. You can associate a specific loan agreement with an asset on the Asset Form.
Manage Loan Agreements

Steps to add or edit Loan Agreements

1. Select Tools → Manage Loan Agreements to open the dialog box.
2. Select a Loan Agreement from the list on the left, or click the "New" button to add a new loan agreement.
3. Edit the Name and/or Text description in the boxes on the right.
4. Click the Ok button when finished making changes.

3.1.3.5 Database Connection

The Database Connection menu (Enterprise Edition only) opens the dialog box which allows you to switch between a local database and a remote database.
Connect to single user local database file (file path):
Select this option to connect to the local database file. This file is located in the Windows All Users Application Data directory by default.

Connect to multi-user database server (Server name or IP Address):
Select this option to connect to a database on a server. Enter the name of the server or the IP Address that your server administrator has provided. The server must have the Firebird database component installed on it. The connection will use TCP/IP. You cannot connect using a shared folder or UNC path. For more information, see the Database Server Configuration Page

Connection Test
Click the "Test Connection" button to verify that your connection is successful.

Check Firebird Version
Click the "Check Firebird Version" button to determine the version of Firebird database in use.

Advanced Tab
DB Port:
Set the port number that the Firebird database server is listening on. The default value is 3050. This value must match the "RemoteServicePort" value set on the server in the firebird.conf file. Note: the Firebird service must be restarted after making changes to the firebird.conf file. Also, be sure to update the windows firewall to allow TCP connections on the specified port number.
DB Name (Alias):
Set the name of the database alias defined in the aliases.conf file on the server. The default value is: "AssetManager" (no quotes or spaces). Note: the Firebird service must be restarted after making changes to the aliases.conf file.

SYSDBA Password:
Enter the value of the Firebird SYSDBA password. This value will be "masterkey" by default, and it can only be changed on the server by your database administrator. If you receive a message which indicates the Login Name / Password was not recognized, try using the default password "masterkey". If this does not work, contact your database server administrator.

3.1.3.6 Import

The Import menu allows you to import the assets, personnel, and vendor data from a .csv file. If your data is currently in MS Excel format (.xls), you will need to save the spreadsheet as a .csv file before importing the data.

Screencast: How To Import Data

Existing records will be updated when the "Update" checkbox is checked on the import tab, or if a matching record cannot be found, the record will be added as a new record. Asset Manager uses the following criteria when checking for a matching record to update:

- **Update Asset Record:**
  If an existing Asset record has a matching Asset Number in the source file, and the fields have been mapped on the Field Mappings tab, the record will be updated with any changes.

- **Update Personnel Record:**
  If an existing Personnel record has a matching Personnel Number or Email Address in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

- **Update Vendor Record:**
  If an existing Vendor record has a matching Vendor Number in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

- **New Asset, Personnel or Vendor Record:**
  If a matching record is not found, a **New** record will be added to the database.

You may import a source file which contains all or only some of the data fields.

**Important:** Be sure to test out your import files on a test database and/or backup your production database prior to importing the data. It is a good idea to develop a repeatable and consistent process for creating your import file if you plan to perform the operation on a regular basis.

Data source tab:
The Data Source tab is the first tab on the Import Wizard accessed using the menu option Tools --> Import. This tab allows you to select an import file and configure the settings to match the import file format.

Import file
The import file is the .csv file which contains the data to import. For example, if you have a list of assets in an Excel spreadsheet, you can save the spreadsheet as a .csv file using the File Save As command in Excel, and then import the asset records rather than entering them all manually.
The following section is an example of the contents of a valid .csv file for Assets. You may copy and paste this data into a Notepad document and save it to test importing the file into the system:

```
AssetType,Barcode,SerialNumber,Model,Condition,AssetName,Brand,Status,Vendor
Electronics,import001,12345678a,XPS,Good,Laptop (Sample Import 1),Dell,In Use,Acme Electronics
Electronics,import002,12345678b,XPS,Good,Laptop (Sample Import 2),Dell,In Use,Acme Electronics
Electronics,import003,12345678c,XPS,Good,Laptop (Sample Import 3),Dell,In Use,Acme Electronics
Electronics,import004,12345678d,XPS,Good,Laptop (Sample Import 4),Dell,In Use,Acme Electronics
```

See Also: Sample .csv file for importing located in the Program Files\Asset Manager directory.

**Malformed .csv File Message:**

MS Excel will sometimes leave out the ending comma if the last column in the file contains data in only some of the rows. For example, if you have a Notes column in the last column of your file, and only a few of the rows have any data in the Notes field, the file may not get saved in a proper .csv format with an ending comma for the empty columns. In this case, you may want to delete the last column and then resave the file for import, or ensure that each row contains data in that column in order for the import file to be saved in a valid .csv format.

You may need to remove any unused or empty columns in your source file to avoid creating a malformed .csv file.

**Additional Troubleshooting For Malformed csv files:**

The "Save As file type" feature in Excel will sometimes create a malformed csv file which cannot be used in the import process; however, you can try exporting to a unicode text file instead. The Unicode text option produces an output similar to tab-delimited text, but it allows for the inclusion of non-ASCII characters such as Chinese, Arabic or Hebrew letters, which otherwise may appear as question marks.

To convert from an Excel file to a tab delimited text file:

2. When using this option, be sure to select the .txt file instead of the .csv file when you select the import source in Training Manager.
3. Also, change the field delimiter to a tab instead of a comma on the Data Source tab.

**File format**

Field Delimiter: For .csv files, the field delimiter will be a comma. This is the character which separates the fields in the file.

Text Qualifier: The Text Qualifier is used to surround the values for each field. For example, if you have a field with a comma in it, you will need to include the value in quotes so that it is recognized correctly.

First row contains column names: Check this box if the first row of your import file contains file names.

**Data preview**

The Data preview section displays the first few rows of the import file so you can check to see if the
settings are correct.

**Field mapping tab:**
This tab provides options for mapping the data from the fields in your source file to the fields in the Asset Manager database. The Source Fields are listed in the column on the left side. For each field that you want to map to a Asset Manager field, click in the area to the right of the field and then select a destination Asset Manager field to map it to.

Source Field: The source field is the name of the field from the import file.
Asset Manager Field: The Asset Manager Field is the corresponding field in Asset Manager to map the source field to.

**Import tab:**
Click the "Import" button on this tab to import the data into the database. A summary of the import results will be provided in the Import Summary section after the import process is completed.

**3.1.3.7 Export**
The **Export** menu item opens the Export Data dialog box with options for exporting data out of the database.

![Export Data dialog box](image)

**Steps to Export Data**
1) Select the menu item Tools --> Export.
2) Set the following options as needed on the Export form:
   a) Record Type: Select the type of records to export.
   b) Data Format: Select the format of the file to create. Hint: .csv files can be opened in MS Excel.
   c) File Name: Click the Browse button and select a location and file name where the data file will be created.
3) Click the Export button to export the data.

**3.1.3.8 Database Security**
Set a password to modify the database using the Database Security dialog.
Steps To Set A Password:

1. Open the Database Security Dialog (menu item Tools --> Database Security)
2. Enter the new password in the space provided.
3. Click the Ok button.
4. Enter the new password again to confirm it.
5. Click the Ok button to complete the change.

Allow check-in while in read-only mode
Check this box to grant "Check-In" permissions to users who have opened the software in read-only mode. While in read-only mode, the user will not be able to modify other areas of the database, but they will still be able to Check-In assets if this checkbox is checked. This setting is applied to all users who open the software in Read-Only mode.

Allow check-out while in read-only mode
Check this box to grant "Check-Out" permissions to users who have opened the software in read-only mode. While in read-only mode, the user will not be able to modify other areas of the database, but they will still be able to Check-Out assets if this checkbox is checked. This setting is applied to all users who open the software in Read-Only mode.

Automatically open in read-only mode on this computer
Check this box if you would like the software to automatically open in Read-only mode. This setting impacts the individual computer only.

Remember password on this computer
Check this box if you would like the password to be automatically filled in for you. This setting will "remember" the password you have entered, and will pre-populate the password box the next time it is opened. This setting impacts the individual computer only.
3.1.3.9 Barcode Reader Setup

Access the Barcode Reader Setup form using the menu option Tools --> Barcode Reader Setup. When scanning an item, Asset Manager will listen for a termination character to identify the end of the scan characters. This form allows you to set the value that Asset Manager uses when listening for a scan reading. The value should be set to match what has already been set on your barcode reader.

**Note:** If Asset Manager opens a record when you scan an item, then your barcode reader configuration already matches the Asset Manager configuration, and you do not need to make any changes.

You may select or enter the termination character that your barcode reader uses, or place the cursor in the Scan test area and scan an item to let Asset Manager attempt to determine it. Many barcode readers are set to use a Carriage Return as the termination character.

**See Also**

- Barcode Readers
- Barcode Reader Test

3.1.3.10 Options

Access the Options form using the menu option Tools --> Options.
3.1.4 Help

The Help menu contains the menu items listed below. Click a link below for complete details.

Help Menu Items


3.1.4.1 Contents

The Contents menu opens this User Guide.

3.1.4.2 Check for updates

The Check for updates menu initiates a connection to our update server to compare the version of the software you are using with the current version of the software. A pop-up message will notify you to let you know whether you are using the current version of the software. If you are using an older version, you will be provided with an option to download the update. To install the update, download the setup file when prompted, and click Open or Run to update your software. Your database will remain intact, so you will not lose the data that has been previously entered.

Some updates may require a change to the database schema after the software has been updated. In these cases, you will be notified the first time you open the new version that it needs to update the database. If you receive this message, it is important that no one else has the software open before you continue, and Asset Manager will automatically update the database schema for use with the current version of the software.

In a multi-user environment, it is important that all users have the same version of the software installed. Users with an older version of the software may receive an error message when connected to a database which has been updated.

If a corporate firewall prevents you from connecting to our update server, you may also download the software from the downloads page on our website. This is the same software which can be downloaded through the Check for updates menu.

For information about the changes that have occurred, check the Product Updates section on our blog.

3.1.4.3 Ask a question

The menu option Ask a question / Send feedback will open a dialog box you can use to contact Support. You may use this form to contact us about:

- Question
- Enhancement Request
- Bug Report
- Other Feedback
3.1.4.4 About Asset Manager

The About Asset Manager menu item opens a dialog box with information about the currently installed Asset Manager software, including the version number.

3.2 Assets

Asset records contain the details for specific Assets. For complete details, see the following sections:

- Assets List View
- Asset Form
- Check In
- Check Out
- Audit Record

3.2.1 Assets List View

The Assets list view displays a list of assets that have been entered into the database.
Also See:
Screencast: How to manage asset types and locations
Screencast: How to locate an asset record

Quick Search:
Enter a few characters of the asset name or number in the Search box near the upper right to quickly filter the list.

Toolbar Buttons:

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Asset</td>
<td>Opens a new Asset form. Use this to add a new asset record to the database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the currently selected (highlighted row) asset.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected asset.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Export options dialog box to allow you to export the list of Assets to a .csv file.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Opens the asset barcode report for printing barcode labels. The report contains the barcodes for all of the selected assets.</td>
</tr>
<tr>
<td>Audit</td>
<td>Opens the Audit Record dialog box. Use this to add an audit record to the asset history. For example, you may print an Overdue Audit report on the Report tab, and then confirm each asset in the database, adding an Audit record for each item that has been confirmed.</td>
</tr>
<tr>
<td>Check In</td>
<td>Click the Check In button to check in the selected asset(s).</td>
</tr>
<tr>
<td>Check Out</td>
<td>Click the Check Out button to check out the selected asset(s).</td>
</tr>
</tbody>
</table>
1. **Sorting:**
Click on a column header to sort the data by that column. Click again to re-sort the column in the opposite direction.

2. **Show Columns:**
Right-click anywhere on the list to display the context menu, then select "Show Columns" to select which columns you would like to display in the list.

### 3.2.2 Asset Form

The **Asset form** contains the details for a specific session of Asset.

![Asset Form](image)

**Fields and Form Elements**

<table>
<thead>
<tr>
<th>Field or Form Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save &amp; Close</td>
<td>Click the Save &amp; Close button to save the current form and close it.</td>
</tr>
<tr>
<td>Audit</td>
<td>Click the Audit button to add an Audit record to the asset history.</td>
</tr>
<tr>
<td>Check Out (F3)</td>
<td>Click the Check Out button or press the F3 button</td>
</tr>
</tbody>
</table>

© 2019 Kaizen Software Solutions
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A text field which contains a description of the asset.</td>
</tr>
<tr>
<td>Asset Type</td>
<td>A selection field which contains the list of Asset Types. You may add a new asset type here by</td>
</tr>
<tr>
<td></td>
<td>placing the cursor in the selection field area and typing the name of the new asset type. The</td>
</tr>
<tr>
<td></td>
<td>value will appear in the selection field and in the Asset Types navigation folder on the list</td>
</tr>
<tr>
<td></td>
<td>view.</td>
</tr>
<tr>
<td>Location</td>
<td>A selection field which contains the list of Locations. You may add a new location here by</td>
</tr>
<tr>
<td></td>
<td>placing the cursor in the selection field area and typing the name of the new location. The</td>
</tr>
<tr>
<td></td>
<td>value will appear in the selection field and in the Location navigation folder on the list view.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>A text field which contains the name of the Manufacturer.</td>
</tr>
<tr>
<td>Brand</td>
<td>A text field which contains the name of the Brand.</td>
</tr>
<tr>
<td>Model</td>
<td>A text field which contains the name of the Model.</td>
</tr>
<tr>
<td>Asset Number</td>
<td>The Asset Number is a unique number which identifies the asset record in the database. This</td>
</tr>
<tr>
<td></td>
<td>number is also used for the barcode. Select Automatic to have Asset Manager assign the number</td>
</tr>
<tr>
<td></td>
<td>for you, or select Manual to set the value to an existing asset number. If you already have a</td>
</tr>
<tr>
<td></td>
<td>barcode on the asset, you may select &quot;Manual&quot;, and then place the cursor in the Asset Number</td>
</tr>
<tr>
<td></td>
<td>field and scan the barcode to fill in the Asset Number for you.</td>
</tr>
<tr>
<td>Loan Agreements</td>
<td>A selection field which contains the list of Loan Agreements. You may manage the loan agreements</td>
</tr>
<tr>
<td></td>
<td>by clicking the button next to the field. Loan agreements will appear on the Check Out form just</td>
</tr>
<tr>
<td></td>
<td>above the Signature area.</td>
</tr>
<tr>
<td>Include In Audits checkbox</td>
<td>Check this box if the asset should be included in the Audit reports.</td>
</tr>
</tbody>
</table>

**See Also**

General  
Finance  
Service  
Notes and Attachments  
History

### 3.2.2.1 General

The General tab on the Assets form is used to track additional information about the asset.
Asset General tab

Fields and Form Elements

<table>
<thead>
<tr>
<th>Field or form element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>A text field to track the serial number for the asset.</td>
</tr>
<tr>
<td>Status</td>
<td>A selection field to track the Status of the asset. Add, edit, or delete the Status values using the menu option Tools --&gt; Manage Selection fields.</td>
</tr>
<tr>
<td>Condition</td>
<td>A selection field to track the Condition of the asset. Add, edit, or delete the Condition values using the menu option Tools --&gt; Manage Selection fields.</td>
</tr>
<tr>
<td>Checked out to</td>
<td>The read-only field containing the name of the person the asset is checked out to. Click the button to the right of this field to open the personnel form for this person. You may also press the F3 button on the keyboard to check the asset back in or out.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date when this asset is due back for return.</td>
</tr>
<tr>
<td>Notes</td>
<td>Free text notes about the asset.</td>
</tr>
<tr>
<td>Picture</td>
<td>A picture of the asset. Click the Browse button to select a picture file, or drag and drop a picture into the picture box to change it. Click the Clear button to remove the picture.</td>
</tr>
</tbody>
</table>

See Also

Finance
Service
Notes and Attachments
History
3.2.2.2  Finance

The Finance tab includes additional fields for tracking Finance related information.

![Asset Finance tab]

**Fields**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>A selection field for tracking the Vendor for this asset. Select an existing value, or type in a new value to automatically add a new Vendor to the Vendor list.</td>
</tr>
<tr>
<td>Account Code</td>
<td>A text field for tracking the account code associated with an asset. You may set the default value for this field by right-clicking on the Asset Type folder and then editing the properties for the asset type.</td>
</tr>
<tr>
<td>PO Number</td>
<td>A text field for tracking the PO Number associated with the asset.</td>
</tr>
<tr>
<td>Purchase Price</td>
<td>The price which was paid for the asset.</td>
</tr>
<tr>
<td>Market Value</td>
<td>The current market value of the asset.</td>
</tr>
<tr>
<td>Scrap Value</td>
<td>The scrap value of the asset.</td>
</tr>
<tr>
<td>Purchased</td>
<td>A date field containing the date when the asset was purchased.</td>
</tr>
<tr>
<td>In Service</td>
<td>A date field containing the date when the asset was placed in service.</td>
</tr>
<tr>
<td>Warranty End</td>
<td>A date field containing the date when the asset warranty ends.</td>
</tr>
<tr>
<td>Recovery Period</td>
<td>The expected life of the asset in years.</td>
</tr>
<tr>
<td>Depreciation Method</td>
<td>The method used to depreciate the asset.</td>
</tr>
</tbody>
</table>
Depreciation Methods

**Straight Line**
The Straight Line depreciation method depreciates the asset evenly over time from the beginning book value to the scrap value.

Annual Depreciation Expense = Cost of asset - scrap value / recovery period

For example, an asset purchased for $5500 with a scrap value of $500 and a recovery period of 5 years would depreciate by $1000 per year.

i.e. Annual Depreciation Expense = (5500 - 500)/5 = 1000

The beginning and ending period will be pro-rated according to the number of months the asset was in service for the year.

**200% Declining Balance**
The Double Declining Balance depreciation method depreciates the asset at twice the Straight Line rate.

Using the example for Straight Line depreciation, the depreciation is $1000 per year, which is 20% (i.e. 1000/5000). The 200% Declining Balance depreciation method depreciates the asset at twice that rate, or 40% (i.e. 2 X 20%). It will be pro-rated according to the number of months the asset was in service for the year.

**150% Declining Balance**
The 150% Declining Balance depreciation method depreciates the asset at 1.5 times the Straight Line rate.

Using the example for Straight Line depreciation, the depreciation is $1000 per year, which is 20% (i.e. 1000/5000). The 150% Declining Balance depreciation method depreciates the asset at 1.5 times that rate, or 30% (i.e. 1.5 X 20%). It will be pro-rated according to the number of months the asset was in service for the year.

**20% Reducing Balance**
The 20% Reducing Balance depreciation method depreciates the asset by 20% of the (Book Value - Scrap Value) per year. The depreciation for the last year will be the difference between the Book Value and the Scrap Value so that it will be fully depreciated. Partial periods will be pro-rated according to the percentage of time the asset was in service for the period.

You may add other rates using the menu option Tools --> Manage Selection Fields.

**Sum of Years**
The Sum of Years depreciation method calculates the depreciation rate on a schedule of fractions based on the sum of the number of years of depreciation.

For example, the sum of years for an asset with a Recovery Period of 5 years is: 5 + 4 + 3 + 2 + 1 = 15. The Sum of Years depreciation method will depreciate the asset over the years as follows: 5/15 for the 1st year, 4/15 for the 2nd year, 3/15 for the 3rd year, 2/15 for the 4th year, and 1/15 for the 5th year. Partial year depreciation will be added in for assets which go in service during the year on a date other than the 1st day of the fiscal year.

See Also

General
Service
3.2.2.3 Service

The Service tab contains a list of the service (maintenance, inspection, or repair) that has been completed for the asset.

![Asset Service tab]

- Click the New Service Entry button to add a new completed service entry, or to schedule service to be performed.
- For completed service, fill in the Completed Date on the service entry form.
- For Scheduled service, fill in the Next Due date on the service entry form.
- Fill in both dates to indicate the service has been completed and to reschedule it for future service.
## Service Entry form

### Field Name | Description
---|---
Description | A description of the service which has been completed or scheduled.
Type | A selection field to categorize the service as Inspection, Maintenance, or Repair. You may also add or edit service types by going to Tools --> Manage Selection Fields.
Labor Cost | The cost of the labor for this service.
Parts Cost | The cost of the parts for this service.
Tax | The cost of the tax for this service.
Completed | The date when this service was completed. If it has not been completed yet, uncheck the checkbox in the date field.
Next Due | The date when this service is due again. If this service is not performed on a regular schedule, uncheck the checkbox in the date field. An overdue service warning will appear when attempting to check out an asset after the "Next Due" date.
Serviced By | The name of the person who performed the service.
File Attachments | An area for storing file attachments related to this service. You may add scanned documents, data...
| Comments | A text field to store any related comments about this service. You may want to track any abnormalities or other findings involved with the service. |

**See Also**

General  
Finance  
Notes and Attachments  
History

### 3.2.2.4 Notes and Attachments

Add free text notes on the Notes tab.

You can add links to files on the Notes tab using the file protocol.  
Example: `<file:///[Path to file]>`

You may also add file attachments on the Attachments tab.

[Screencast: How to attach files to a record](#)

**See Also**

General  
Finance  
Service  
Notes and Attachments  
History

### 3.2.2.5 History

The Asset History tab contains a listing of the Check In/Out, Audit, and Location change events. Notes will be included if you enter notes when checking the item in/out or when adding an audit record to an asset. The name of the computer user and computer name as well as any notes entered at the time of the event will also be recorded.
Asset History tab

See Also

General
Finance
Service
Notes and Attachments

3.2.3 Check In

Check an item in from a person using the Check In form.
Check In Form

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items to check in</td>
<td>The list of items to check in.</td>
</tr>
<tr>
<td>Search</td>
<td>Place the cursor in the search box and then scan an item to check in, or enter some text to search for it.</td>
</tr>
<tr>
<td>Set Status To</td>
<td>Select the new status value for the asset.</td>
</tr>
<tr>
<td>Set Location To</td>
<td>Select a new Location for the asset.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter any comments about the check in.</td>
</tr>
<tr>
<td>Complete Check In Button</td>
<td>Click the &quot;Complete Check In&quot; button to complete the check in of the items listed in the &quot;Items to Check In&quot; box.</td>
</tr>
<tr>
<td>Print Check In Receipt checkbox</td>
<td>Check the box to print a Check In Receipt when completing the Check In.</td>
</tr>
</tbody>
</table>

3.2.4 Check Out

Check an asset out to a person using the Check Out form.
### Field Label

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan badge</td>
<td>Place the cursor in the Scan Badge field and then scan a person's badge to automatically select their name in the list.</td>
</tr>
<tr>
<td>Select person</td>
<td>Alternatively, select the person's name from the selection list.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Set a date when the asset is due for return.</td>
</tr>
<tr>
<td>Set Status To</td>
<td>Select a new Status value for the asset.</td>
</tr>
<tr>
<td>Set Location To</td>
<td>Select a new Location for the asset.</td>
</tr>
<tr>
<td>Items to check out</td>
<td>The list of items to check out to the selected individual.</td>
</tr>
<tr>
<td>Search</td>
<td>Place the cursor in the search box, and then scan an item to add, or enter a description to find an asset to add to the check out list.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter any additional Comments for this check out.</td>
</tr>
<tr>
<td>Complete Check Out button</td>
<td>Click the &quot;Complete Check Out&quot; button to complete the check out for the items listed in the &quot;Items to Check Out&quot; box.</td>
</tr>
<tr>
<td>Print Check Out Receipt checkbox</td>
<td>Check the box to print a Check Out Receipt when completing the Check Out.</td>
</tr>
</tbody>
</table>
Note: An "Overdue Service" warning will appear when attempting to check out an item which is overdue for service. The warning is to alert the operator, but it will not prevent you from checking out the asset. To prevent the warning from appearing again, either add a new completed service record with an updated next due date, or uncheck the next due date if the service is not required.

3.2.5 Audit Record

The Audit Record dialog box is used to add an Audit Record to one or more assets. This may be used for a periodic "audit" or "stock take" of assets.

**Portable Barcode Scanners:**

1. Walk around to locate assets and scan their barcodes into the scanner memory.
2. Return to your computer and export the list of scanned barcodes to a text file.
3. Click the Audit button on the Asset list view.
4. Copy/Paste the list of scanned barcode numbers into the Asset Number box. Enter a note as needed, and then click the "Add Record" button. The scanned items will no longer appear on the Audit Checklist or Overdue Audit report.

**Barcode Scanner Connected To PC:**

1. Print the "Audit Checklist" report (set the Data Options to Group by Location).
2. Walk around to locate the assets and check them off on the list.
3. Return to Asset Manager and click the Audit button on the Asset list view.
4. With the cursor located in the "Asset Numbers" box, scan each barcode on the Audit Checklist that has been checked.
5. Enter a note as needed, and then click the "Add Record" button. The scanned items will no longer appear on the Audit Checklist or Overdue Audit report.

After auditing all of the assets in the locations as needed, you may run the "Audit Checklist" report again. If unaudited assets remain, you may wish to click the "Data Options" button and group the report by "Custodian" this time in order to follow up with the appropriate personnel.

### Fields and Form Elements

<table>
<thead>
<tr>
<th>Field or Form Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset: Multiple assets selected</td>
<td></td>
</tr>
<tr>
<td>Audited: Friday, March 05, 2010</td>
<td></td>
</tr>
<tr>
<td>Asset Numbers:</td>
<td></td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
</tbody>
</table>
3.3 Personnel

Personnel records contain the details for all Personnel. For complete details, see the following sections:

- Personnel List View
- Personnel Form

3.3.1 Personnel List View

The Personnel List View displays a list of the personnel records that have been stored in the database.

**Filters:**
- Active: Show only personnel with a status of Active in the list view.
- Inactive: Show only personnel with a status of Inactive in the list view.
- All: Show all personnel in the list view.

**Quick Search:**
Enter a few characters of the person's name, number, group, or job role in the Search box near the upper right to quickly filter the list.

Toolbar Buttons:

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Personnel</td>
<td>Opens a new Personnel form. Use this form to add new employees or trainers to the database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the currently selected (highlighted row) personnel.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected personnel.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Export options dialog box to allow you to export the list of Personnel to a .csv file.</td>
</tr>
</tbody>
</table>

Sorting:
Click on a column header to sort the data by that column. Click again to re-sort the column in the opposite direction.

Show Columns:
Right-click anywhere on the list to display the context menu, then select "Show Columns" to select which columns you would like to display in the list.

3.3.2 Personnel Form

The Personnel form is used to manage the details for each person in the database.
### Personnel Form

#### Fields and Form Elements

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The first and last names of the person.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>The work phone number for the personnel.</td>
</tr>
<tr>
<td>Home Phone</td>
<td>The home phone number for the personnel.</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>The mobile phone number for the personnel.</td>
</tr>
<tr>
<td>Pager</td>
<td>The pager number for the personnel.</td>
</tr>
<tr>
<td>Email</td>
<td>The Email field is used to store the email address for the person.</td>
</tr>
<tr>
<td>Personnel Number</td>
<td>You may select Automatic to have Asset Manager assign a personnel number, or select Manual to manually enter a personnel number.</td>
</tr>
<tr>
<td>Title</td>
<td>The Job Title for the personnel. You may select an existing job title or add a new one.</td>
</tr>
<tr>
<td>Group</td>
<td>The Group selection field is the name of the Personnel Group that the person belongs to. You may select an existing Group or enter a new one.</td>
</tr>
<tr>
<td>Status</td>
<td>The employment status for the personnel.</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Picture</td>
<td>Click the Browse button to select an employee picture. To remove a picture, click the Clear button. You may click on the picture to open it in another window.</td>
</tr>
</tbody>
</table>

**See Also**

- Assets Checked Out
- Attachments and Notes
- History

### 3.3.2.1 Assets Checked Out

The Assets checked out tab is located on the Personnel Form. It contains a listing of the assets that are currently checked out to the individual.

![Assets Checked Out tab](image)

**Toolbar buttons**

- Check In: Click the check in button to open the Check In form and check the selected asset back in.
- Check Out: Click the Check Out button or press the F3 key on your keyboard to open the Check Out form and check out another asset.
- Open: Click the Open button to open the selected asset record.

**See Also**

### 3.3.2.2 Attachments and Notes

Add free text notes on the Notes tab.

You can add links to files on the Notes tab using the file protocol.

Example: `<file:///Path to file>`

You may also add file attachments on the Attachments tab.
3.3.2.3 History

The History tab on the Personnel Form displays the check in/out history for the person.

![Personnel History tab](image)

3.4 Vendors

Vendor records contain the details for the Vendors with whom you do business. For complete details, see the links below.

See Also

- Vendors List View
- Vendor Form

3.4.1 Vendors List View

The Vendors List View displays a list of the Vendors that have been stored in the database.
Vendor List View

**See Also**

Vendors Form

### 3.4.2 Vendor Form

Add and edit Vendors on the **Vendor form**.
3.4.3 Attachments and Notes

Add free text notes on the Notes tab.

You can add links to files on the Notes tab using the file protocol.
3.5 Reports

Asset Manager comes with several built-in reports to provide Asset information for your organization.

**Reports Tab**

- Select a report on the left to preview it in the report preview area.
- Click on the report preview to zoom in or out.
- Standard filters, grouping, and sorting options are available by clicking the Data Options button below the report list.
- Some reports allow additional filters to be applied. Additional filters will appear below the report selection area when available.
- Open the report in a new window for additional export options, or print the current report using the Print button.
- Click the Refresh button to update the report if you have added or updated data since the report was last previewed.
3.6 Barcode Scanning

See the sections listed below for information about barcode readers and barcodes used in Asset Manager:

- Barcode Label Printing
- Barcode Readers
- Barcode Reader Test
- Barcode Reader Setup

3.6.1 Barcode Label Printing

Label printing options allow you to control the size and layout of your barcode labels for Assets and Personnel badges. You may print a label from the following areas within Asset Manager:

1. On the Assets tab, select one or more Assets in the list, and then click the Barcode button in the toolbar.
2. On the Reports tab, select the Asset Barcode Labels report and then set the Data Options to filter the data for the labels you want to print.
3. On the Personnel tab, select one or more Personnel in the list, and then click the Barcode button in the toolbar.
4. On the Reports tab, select the Personnel Barcode Labels report and then set the Data Options to filter the data for the labels you want to print.

Labels may be printed in groups on a sheet of label paper using a sheet feed printer, or they may be printed individually to a continuous feed label printer.

**Printing to a sheet feed printer**

To print to a standard office sheet feed printer, select your label template, printer, and page settings. The example below is for printing a sheet of labels on Avery 5160 Label paper (Letter size - 8.5" X 11" in portrait mode).
Label Options: Configured for printing on Avery 5160 Label paper (Letter size - 8.5" X 11")

The output looks like this:

![Avery 5160 Label Sheet](image_url)

**Continuous Feed Printer**
To print individual labels to a continuous feed printer such as a Dymo LabelWriter, select a label or create a new custom label. For example, to create a label template for the "30252 Address" size label, click the "New Label" button, and then set the following values:

**Label Template Settings**

**Label Information**
- **Label Name:** 30252
- **Units:** inches

**Label Dimensions**
- **Label Width:** 2.50
- **Top Margin:** 0.05
- **Label Height:** 1.00
- **Vertical Space:** 0.00
- **Left Margin:** 0.50
- **Column 1**
- **Column 2**
- **Horizontal Space:** 0.00

*New Label Template Example: 30252 Address label*

In this example, we are using a label roll containing 3.50" wide and 1.125" high labels. There is only one column on the roll, so the Vertical and Horizontal space is set to zero. To allow space around the barcode, we are setting the dimensions to 1" X 2.50". This will allow .5" on either side of the barcode, and 1/16th of an inch on the top and bottom. The left margin is set to .50" to shift the label over to the right in order to center it on the label.

Note that the picture in the dialog box is for referencing the location of the dimensions only - it is not to scale and does not change to show different number of columns or sizes.

All new custom templates will appear under the Label Vendor, "*Custom*" as shown below.
The printer, paper, and page settings have been set to print out in the proper orientation on the label.

The completed output will appear like this:
Advanced

Continuous Feed Printer: If you have set the label size for a continuous feed printer and the barcode is printing the correct size, but the label is printing out too far before cutting off, check the "Paper" setting on the Barcode Label Options. If the Paper size is set correctly, but the problem continues, try using the "Auto Continuous" Paper size at the bottom of the Paper selection values. The "Auto Continuous" Paper size will override the paper settings from the print driver, and set the paper to the same size as the label.

See Also

- Barcode Readers
- Barcode Reader Test
- Barcode Reader Setup

3.6.2 Barcode Readers

Asset Manager will work with scanners that support keyboard emulation - these are the types of barcode readers that you hook up to your computer and they send keystrokes to the computer as if they were typed in. We don't have a specific model or brand to recommend, but if you are new to it, there are very inexpensive ones available that allow you to learn how it works with Asset Manager without a big up front investment.

Here’s some additional information about the barcode functionality in Asset Manager:

About Barcode Readers

Asset Manager works with all types of barcode readers that support keyboard emulation (most do). These readers are sometimes referred to as "keyboard wedge" or just "wedge" type scanners. These type of barcode readers plug into your computer through a USB port, and when a barcode is scanned, the reader sends the barcode number to your computer just as if you had typed it in using the keyboard. The advantage the barcode scanner brings is that it can be faster and more accurate than typing in the barcode number yourself, and it will bring up the existing records in the database quickly. There are a variety of models available, and we recommend getting started with a model in the $25 - $75 range to get started if this is new to you. You can find some available on Amazon in this price range at the following links: barcode readers on eBay, barcode readers on Amazon.

Check-In/Check Out With Asset Manager

When you're entering an Asset, you can let Asset Manager assign the barcode number for you using the default Automatic setting, or if the item already has a barcode, you can set the asset number to manual and then place the cursor in the text box before scanning the barcode to use the existing barcode. Note that the each barcode must be unique for each item, so you would only use this option if you have unique barcodes already assigned to items perhaps from a previous system. For example, you would not be able to use the model number barcode to uniquely identify the item if you have multiple items with the same model number.

There are different ways to check out an item in Asset Manager depending on the task you are working on at the moment. For example, when you are on the Personnel screen, and then scan the personnel badge, the personnel record will open to begin checking out multiple items to them (for example to set up a new employee), or you scan a barcode on the Asset screen and open an individual Asset record to check out or check in.
Printing Barcode Labels

Asset Manager comes with a report template for printing barcodes on standard Avery 5160 labels on a standard printer. The barcodes are printed in the standard "Code 128" format. To print one label at a time, you will need a stand-alone printer such as a DYMO LabelWriter 400.

See Also

[Barcode Label Options]
[Barcode Reader Test]
[Barcode Reader Setup]

3.6.3 Barcode Reader Test

If you have a barcode reader/scanner and have been having trouble using it with Asset Manager, you can test it as follows:

You will need an item with a barcode on it available.

First, check to see if the keyboard emulation is working as expected:

1. Open up a blank document such as Notepad, Word, or a new email window.
2. Place the cursor in the document window and then scan any barcode.
3. The barcode number should appear in your document window.
4. Now scan a barcode again.
5. The second time the barcode is scanned, the barcode number should appear in the document window on a second line.

If the barcode number doesn't appear in the document window at all, the keyboard emulation is not working.
If the barcode number appears, but it doesn't separate each scan on a separate line, the scanner needs to be configured to add a line break between scans.

Continue below if the above checks out ok.

Next, check it in Asset Manager:

1. On the asset screen, click "New Asset".
2. Fill in a Description, and then select "Manual" for the Asset Number. Enter the barcode number in the asset number field, or place your cursor in the asset number field and then scan the barcode to fill this field in.
3. Save and close the asset record.
4. Next, while you have asset manager open, scan the barcode again. Asset Manager should open the record that you created in step 1.

If Asset Manager doesn't open the Asset record created in Step 1 when you scan the item, you may need to set the termination character in the Barcode Reader Setup form.

See Also

[Barcode Readers]
[Barcode Reader Setup]
4 System Administration

Select a System Administration topic below:

- Firebird Database Server
- Troubleshoot Connections
- Schedule Daily Database Backup
- Update The Client Software
- Upgrade To Multi-User
- Technical Details
- Move To A New Computer
- Move Database To New Server
- Configure Email Client

Advanced Configuration:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- ODBC Connections

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.

4.1 Firebird Database Server

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.

Network Setup Overview

When you install the Asset Manager client software on your computer, an embedded database is installed by default to allow you to try out the software without further configuration. However, when you're ready to share the software on a network with multiple users, you need to install a shared database on a server. Any Windows computer may act as the database server, as long as it is accessible from all of the computers which need to access the shared database. You also want to make sure the computer is able to run without interruption to avoid any potential for database corruption which might occur if the computer is restarted while users are connecting to and using the database.

There are three basic configurations to choose from. Click on a diagram below to view full size:
Configuration Instructions

Each of the configurations require three basic steps:

1. Install the client software on the computers which will run Asset Manager.
2. Install the database server software on a shared Windows server.
3. Connect the client computers to the database server.

You may watch a 3 minute instructional video, or follow the steps below:

**Step 1: Install the client software**

The client software is the program that users interact with to enter and update Asset records. If you have used the trial version of Asset Manager, then you have already installed at least one copy of this software. This software is available to download at the following link:


Note that in order to connect to a shared database server, you must install the Asset Manager Enterprise Edition. All editions of Asset Manager start in single user stand-alone mode by default. The Enterprise Edition can also connect to a remote central database server.

**Step 2: Install the database server software**

The database server software is very easy to install in the default configuration. To install in the default configuration, follow these steps:

- Log on to your server and download the setup program from: http://www.kzsoftware.com/products/kzfirebird/download.htm.
- Note that this is a different setup program than the one installed on the client computers.
- Run the setup program, and accept all defaults.
- This program will install a Firebird Database Server and a Asset Manager database.

If you are using the Windows Firewall, configure it to allow Inbound TCP connections on Port 3050 as described below:

**For Windows Server 2008, and later (2012, 2016, 2019):**

1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   Rule Type: Port
   Protocol: TCP
   Specific Port: 3050
   Action: Allow the connection.
   Profile: As required.
   Name: Firebird

For Windows Server 2003 and 2000:
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

Step 3: Connect the client computers to the shared database

After installing the database server, connect your client computer(s) to the shared database server by following these steps:

1. Open Asset Manager on one of the client computers which it is installed on.
2. Select the menu option Tools --> Database Connection (Note: if you don't see this option, you need to install the "Enterprise Edition" with multiple user network support from: http://kzsoftware.com/products/asset-management-software/trial.htm)
3. Enter the name of the database server in the connection dialog box (if you don't know the name of the server, log on to the server and right-click "My Computer", choose "Properties", and then select the "Computer Name" tab.) Note that you only need to enter the name of the database server - you do not need to enter a file path when connecting to a remote database server. The file path is only required when connecting to a local database file.
4. Click Ok
5. Close and then reopen Asset Manager. You're now connected to the shared database server.

Note: If you cannot connect to the database server, please see the following section: Troubleshooting Connections.

When you're finished configuring the database connection, set up a scheduled task to backup the database daily.

Advanced - Citrix/Terminal Server Configuration:

If you are installing the client on a Windows Terminal Server, please see the Citrix/Terminal Server Configuration Notes.

Advanced - Database File Storage:

If you are a server administrator and would like to change the default location where the Asset Manager database is stored, you may do so by following the instructions below. Asset Manager is designed to run with the standard options "out of the box", and in most cases there is no reason to change the defaults; however, these instructions are provided for server administrators who would like to change the default installation.

1. First stop the Firebird database service.
2. Next copy the database file from C:\KZSoftware\AssetManager.adb to the new location where you would like it to be stored. Note: the new location must be located on a hard drive that is physically
connected to the host machine. It cannot be located on a mapped drive, a file system share, or a network file system.

3. Next, open the file C:\Program Files\firebird\aliases.config in notepad and change this line: AssetManager=C:\KZSoftware\AssetManager.adb to reflect the new path to the database file.

4. Finally, restart the Firebird database service.

### 4.1.1 Client Server Configuration

**Configuration: Standard Client Server**

- **Scenario:** Single office environment with a database installed on a shared server and multiple users connected from separate desktop/laptop PCs.

- **Role: Database Server**
  - Software: KZFirebird Database*
  - Other: Port 3050 open for TCP

  *KZFirebird package includes Firebird 2.1.3, database files, and default configuration.

- **Role: Client PCs**
  - OS: Windows XP, Vista, 7
  - Software: Client software - Enterprise/Network Edition**

Locally installed client software connects to the Firebird database over TCP port 3050. Use client menu option Tools → Database Connection to connect.

### See Also

- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Multiple Offices: Terminal Server Configuration
4.1.2 Shared Database on PC

**Configuration: Shared Database on PC (No Server)**

**Scenario:**
Small office environment with a database installed on one of the PCs and shared with multiple users.

On the PC which contains both the Firebird database software and the client software, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost". For all other PCs, set the database connection for multiple users and connect to the database by machine name or IP Address.

**See Also**
- Network Setup Overview
- Single Office: Client Server Configuration
- Multiple Offices: Terminal Server Configuration
4.1.3 Terminal Server Configuration

Configuration: Terminal Server

If you have installed both the Firebird database software and the client software on the same server, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost".

See Also
- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Single Office: Client Server Configuration

4.2 Troubleshoot Connections

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition not have the remote database feature available.

If you have completed the steps for installing the Firebird database and are experiencing problems connecting to the database, check the error message description and then locate it in the table below for troubleshooting steps:

<table>
<thead>
<tr>
<th>Connection Error</th>
<th>Potential Causes</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to complete network</td>
<td>1. The server name or IP Address</td>
<td>Step 1: Click the &quot;Ping&quot; button.</td>
</tr>
<tr>
<td>Request to host [hostname].</td>
<td>No connection could be made because the target machine actively refused it.</td>
<td>I/O Error for file &quot;Asset Manager&quot; Error while trying to open file</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>1. The database file is in use by another application and is locked.</td>
<td>1. The Firebird service is not running on the server.</td>
<td>1. If another application has the database opened in single user mode, close the application or connect in multi-user mode to</td>
</tr>
<tr>
<td>2. The Firebird service is not running on the server.</td>
<td>2. If the result is: &quot;No connection could be made because the target machine actively refused it&quot;, then the problem is Cause #2 to the left.</td>
<td></td>
</tr>
<tr>
<td>3. A firewall is blocking access to the port.</td>
<td>If the result is: &quot;Ping Failed&quot;, then the problem is Cause #1 to the left. Verify the server name or IP Address with your server administrator, and confirm that it is accessible on the network.</td>
<td></td>
</tr>
<tr>
<td>4. The port entered on the Advanced tab does not match the port that Firebird is listening on.</td>
<td>Step 2: Click the &quot;TCP/IP Test&quot; button.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the result is: &quot;A connection attempt failed because the connected party did not properly respond after a period of time, or established connection failed because connected host has failed to respond [hostname:port], then the problem is Cause #3, or 4 to the left.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use the troubleshooting steps listed below this table for the specified cause to resolve the problem.</td>
<td></td>
</tr>
</tbody>
</table>

Start the Firebird service in Windows Control Panel --> Administrative Tools --> Services. If the Firebird service is not listed there, install the KZFirebirdServer package as described in the shared database configuration instructions.

If you have run the KZFirebirdServer installer, but the service is not displayed or will not run, an anti-virus software may have interfered with the installation. Temporarily disable any anti-virus software and install KZFirebirdServer again.
2. The database port is in use by another instance of Firebird or other service.

3. The Database Alias name entered on the Advanced tab was not found on the Firebird server.

4. The database file is not in the location on the server specified in aliases.conf.

| Your user name and password are not defined. Ask your database administrator to set up a Firebird login. |
| The value entered in the SYSDBA password field does not match the SYSDBA password on the Firebird server. |
| If the Firebird administrator has changed the SYSDBA password for the Firebird database, request the password or have the administrator enter the password for you in the SYSDBA Password field. |

Note: The SYSDBA password is used by the database server. It is not the same as the application passwords that have been set up for personnel to login to the client software.

Leave the setting as the default value unless it has been changed on the server.

| Unsuccessful execution caused by a system error that precludes successful execution of subsequent statements. |
| This message may appear when attempting to use the database from a file share. A database being accessed through a file share is subject to data corruption. Firebird is designed to run in client-server configuration for multiple users. |
| Install and connect to Firebird as described in the Shared Database Configuration instructions. |

| Any other error message not listed above. |
| Unknown |
| Check each of the items listed below and then try again. If the |
Check the Windows firewall

The Windows firewall is a frequent cause for not being able to connect to the server. Make sure port 3050 is available for Inbound TCP connections on the server. Here are the steps:

For Windows 2003 and earlier:
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

For Windows 2008 and later:
1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   - Rule Type: Port
   - Protocol: TCP
   - Specific Port: 3050
   - Action: Allow the connection.
   - Profile: As required.
   - Name: Firebird

Check the Firebird database process

If you have already configured the firewall and are still unable to connect, please check to see if the Firebird database process is running on your server.

1. Open the Windows Task Manager: Start --> Run --> enter "taskmgr", and then click the Ok button.
2. Go to the processes tab, and make sure the checkbox for show processes for all users is checked.
3. Sort the processes by clicking on the Image Name column header and look for a process named fb_inet_server.exe (if running the default Firebird Classic), or fbserver.exe (if running Firebird Super Server).
4. If the process is not there, please install the Firebird Server.

Confirm the database connection setting

If you have configured the Firewall and the database process is running, confirm that the database connection setting on the client is correct.

- Log in to the Enterprise client, and go to Tools --> Database Connection.
- Confirm that the bottom radio button is selected for a multi-user database. If the top radio button is selected, only a single user will be able to access the database - the database will be locked and an **I/O error** will occur for subsequent connection attempts.
- Confirm that the name of the database server is entered correctly. It should be the name only, no slashes, file paths, etc. To find the name of your database server, log on to the server and then right-click "My Computer", choose "Properties", and then select the "Computer Name" tab. If the DNS is not resolving the computer name correctly, you may need to use the IP Address instead.

If the problem continues, there may be an anti-virus or other security software blocking the process on
the server.

**Check firebird.log for errors**

Log in to the server, and check the firebird.log file in the Program Files \ Firebird directory for errors.

You may see an error such as the following: "INET/inet_error: select in packet_receive errno = 10038"

--> This error indicates that the Firebird server process cannot operate correctly due to network interference which may be caused by an anti-virus or other security software blocking it. Check your security software and exclude the Firebird process or temporarily disable the security to test the connection again.

inet server err: setting **KEEPALIVE** socket option or inet server err: setting **NODELAY** socket option

--> This error may indicate that you need to use the "SuperServer" version of Firebird instead of the "Classic" version. You can download the SuperServer version [here](#).

### 4.3 Schedule Database Backup

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.

You can set an automated schedule for backing up a server based database every day using the Windows Scheduled Tasks utility. For convenience, batch files are included in the Firebird bin directory to create the scheduled tasks and to backup the database.

**Automatic Configuration of the Scheduled Tasks**

Use these steps to create a Windows scheduled task on your server to automatically backup your database.

1. Locate the batch file on your server at: 
   `*C:\Program Files\Firebird\KZFirebird\bin\ScheduleAMBackup.bat`
2. Double-click the batch file to run it. If you get an Access Denied message, right-click on the file and choose "Run as Administrator".

*The Firebird directory may be in the "Program Files" or "Program Files (x86)" directory. If the batch file does not exist on your server, perform the manual configuration described in the next section.

**Important:** Run the scheduled task to test it as described below the next section and confirm that the database backup file is created as expected.

**Manual Configuration of the Scheduled Tasks**

Follow these steps to configure the scheduled task manually only if your installation does not contain the "BackupAssetManager.bat" file, or the automatic configuration was not successful. If your scheduled task has already been created, skip to the next section to test it.

1. Download the backup batch file - right-click on the link below and select "Save Target As" or "Save Link As".
   Batch File: [Backup Asset Manager](#)
2. Save the file to the Firebird bin directory at: 
   `C:\Program Files\Firebird\KZFirebird\bin`
   The batch file must be located in the bin directory which contains the gbak utility.
Windows 2008/2012/2016:

In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler
- or - Start --> Run --> control.exe schedtasks
Click the "Create Task" link in the Actions pane on the right side of the window, and then set the following:

General Tab:
Enter a Name: Backup Asset Manager
Enter a description: Backup the Asset Manager database
Select "Run whether user is logged on or not"

Triggers Tab:
Add a new trigger to run the task Daily.

Action Tab:
Add a new Action to "Start a program".
Select the BackupAssetManager.bat file which you have previously saved in the KZFirebird\bin directory.

Windows 2000/2003:

1. In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Scheduled Tasks
   - or - Start --> Run --> control.exe schedtasks
2. Click "Add a scheduled task"
3. Click "Next"
4. Click "Browse..." and then select the batch file you downloaded in Step 1.
5. Select the radio button to perform this task "Daily"
6. Click "Next"
7. Select a start time and then click the "Next" button.
8. Enter the user name and password for the Windows account which will be used to execute the task, and then click the "Next" button.
9. Click the "Finish" button.

Important: Run the scheduled task to test it as described below and confirm that the database backup file is created as expected.

Run the scheduled task and confirm the operation.

- In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler
- or - Start --> Run --> control.exe schedtasks
- Right-click on the scheduled task you created and select "Run".
- A console window will open and execute the command automatically before closing.
- After the window closes, confirm that a backup file has been created in the folder at C:\Backup.
- The backup file will be compressed, and may be much smaller than the uncompressed database file.
- If the backup file is not created, open the batch file in Notepad, and confirm/update the file path to the gbak utility if needed.
- When finished, log off the computer and allow the backup task to run at it's scheduled time, and then confirm that a new file has been created when the task ran as scheduled.
- After you have confirmed that the backup file is being created as expected, be sure to update your organization's disaster recovery preparedness procedures to include the system information. A
A good plan will include a schedule to periodically audit the process and test a database recovery on a separate test system.

**More information about the batch file**

- By default, the batch file will keep the 10 most recent backups of your database.
- On the 11th day, the oldest backup file will be replaced with the current backup file.
- Backup files are named using the database name plus a number at the end. The most recent backup file ends with the number 1. The oldest backup file ends with the number 10.
- The default backup location is at C:\Backup.
- The default number of copies to keep and the default backup location may be changed by editing the batch file in Notepad.
- Right click on the batch file and select "Edit" to make changes.
- Change only the values listed in the SET statements at the top of the batch file.
- Make only one change at a time, and test between each change to aid troubleshooting if necessary.

### 4.4 Update The Client Software

**Client Software Updates**

As new releases become available, you may upgrade the Asset Manager software as follows:

1. Make sure no one else is using the database (all other users should have Asset Manager completely closed).
2. Make a backup of the database for safety (File -> Backup).
3. Use the menu option Help -> Check for updates, and follow the installation prompts, or if you are unable to connect to our update server, close Asset Manager, and then install the current version of the software from our website. This will not overwrite your existing database.
4. After the update completes, open the software. If any database schema updates are required, a message will appear as shown below in the "Database Schema Updates" section. Wait until all updates have completed before any other users open the software.
5. Make sure all other users update their software to the same version to avoid any mismatched version conflicts.

You can find out more information about the changes in each update in the Product Updates section on our website.

Note: If your license is over 2 years old and you do not have a current support subscription, a 50% update charge may apply.

**Database Schema Updates**

Some updates to the software will also require an update to the database schema. When Asset Manager is opened, it checks the database to see whether a schema update is required. If the database schema requires an update, the following message will appear:
When you are sure no one else has the software open, click **Yes**, and then wait while the database schema is automatically updated. It is important to allow the update to proceed without interruption to ensure the integrity of the update. The database could become corrupted if the update is interrupted by turning off the computer, or if another user attempts to login to the database while the schema update is taking place.

### Mismatched Versions

After a database schema update has taken place, all computers with the software installed should be updated to the same version. When a version of the software which was designed for an older database schema is used to connect to a newer database schema, the following message will appear when the software is opened:

In addition, an error message will appear when performing any function which requires the new database schema. To prevent the error messages, coordinate all updates so that all users are running the same version of the software.

#### 4.5 Upgrade To Multi-User

If you start out with a standalone database on a single computer and then decide to change to a shared database for multiple computers, you can copy your existing data to the server so that you don't lose your previous work. The basic process is to create a backup file of your local database before the switch over, and then restore it to your new server database.

**Steps to upgrade to multi-user**

1. Backup your local database (menu option: File --> Backup). This will create a compressed backup file containing your data.
2. Install and configure the remote database server (to be performed by server administrator). See instructions here:
   - [Shared Database Configuration](#)
3. Install the Enterprise edition of the client software on your computer if it is not currently installed. A link to install the client software is included in the instructions at the link above.

4. Connect to the remote database server (menu option: Tools --> Database Connection).

5. Restore your local database backup copy to the server (menu option: File --> Restore). Select the backup file that you created in Step 1, and then click the Restore button.

6. You can then install the Enterprise edition on additional user's computers and connect them to the remote database server (step 4).

Note: if you are currently licensed for a standalone version of the software only, you will need to purchase an upgrade license key to continue adding new data to the server database. Refer to the link in your original license notification email, or contact us through the Support page on our website at www.kzsoftware.com. Let us know what your current license number is, and we will provide you with a link to purchase an upgrade license.

4.6 Technical Details

**System Requirements**

The initial installation of the Firebird Server for your database will require 27 mb.

The normal rate of growth of the database file without file attachments is 1 MB per 7000 records. Pictures in the personnel records can be added at a rate of about 6 MB per 100 personnel.

If file attachments are added to records, the database will grow in size based on the size of the attachments.

**Client:**
- Required Disk Space: 90 mb
- Minimum CPU: 1 Ghz
- Operating System: Windows 7 or higher (7, 8, and 10) - 32 or 64 bit.
- Notes: The setup process will download and install the .NET Framework v 4.5.2 if it is not already installed.

**Database Server:**
- Required Disk Space: 27 mb for the Firebird server component.
- Minimum CPU: 1 Ghz
- Ports: The server must accept TCP connections on port 3050.
- Notes: KZFirebirdServer.exe will install the Firebird server v. 2.1.7 and the default database files. No additional components such as .NET or Java are required on the server.

**Asset Manager Database**

- Asset Manager stores all of the data and pictures in a single database file.
- Asset Manager Database files have the file extension “.adb”.
- Asset Manager backup files are compressed to save space and have the file extension “.abk”.
- Asset Manager uses the open source Firebird database version 2.1.7 for data storage.
- The local database is stored at the following location:
  - Windows XP (for older versions of the software): C:\Documents and Settings\All Users\Application Data\AssetManager\AssetManager.adb
  - Windows 7, 8, and 10: C:\Program Data\Asset Manager.adb
- The remote database is stored at the following location on the database server:
  - C:\KZSoftware\AssetManager.adb
- Third-party applications can read the Asset Manager database via ODBC. See additional information at the following link:
Firebird ODBC Connection.

Firebird Facts

Firebird in the Enterprise

Get to know Firebird
http://www.firebirdnews.org/docs/fb2min.html

4.7 Move To A New Computer

If you get a new computer or need to move the Standard (single user) Edition of Asset Manager to another computer, you may do so as follows:

**On the Original computer:**

1. Go to the menu option Help --> Enter License Key, or Help --> About, and write down your license key and version number to use later.
2. Go to the menu option File --> Backup, and create a backup file.
3. Copy the backup file created in step 2 from the old computer to the new computer.

**On the New computer:**

4. Download and install the same edition and version of the software from the Software Archive, and then go to the menu item Help --> Enter License Key, and enter the license key number from Step 1.
5. Select the menu option File --> Restore, and then select the backup file that you copied over from the old computer.
6. Close and then reopen Asset Manager.

4.8 Move Database To New Server

If you need to decommission an older server or move your database for another reason, you may move an existing database from one server to another by backing up the old database and restoring it to the new database as described below. Be sure to follow the steps carefully and check which database you are connected to when performing the restore operation in order to avoid overwriting your old database.

1. While connected to your ORIGINAL server, create a backup of the database using the Asset Manager menu option File --> Backup. This will create a compressed backup file with the name and location that you choose.
2. Install the Firebird Database component on your NEW server. See Step 2 in the Firebird Database Server configuration instructions for details.
3. Connect Asset Manager to the NEW server as described in Step 3 of the Firebird Database Server configuration instructions. Close and reopen Asset Manager, and make sure you are connected to the NEW database.
4. Now restore the data to the NEW server from the backup file that you created in Step 1. Use the restore feature available in Asset Manager from the menu item File --> Restore. Select the backup file that you created in Step 1, and then click the Restore button to overwrite the NEW database with the data from your backup file.
5. After you have completed restoring the data from your ORIGINAL server to your NEW server, make sure all computers which are using Asset Manager have been updated to connect to the NEW server (Tools --> Database Connection), and then shut down or remove the Firebird services from the
original server to make sure no one mistakenly uses it.

4.9 Configure Email Client

When sending class session reminders or reports, Training Manager will attempt to open the email client which has been configured in Windows as the "Default" email client. You can designate which email client is the default one as follows:

In Windows XP:

1. Open Internet Explorer
2. Select Tools --> Internet Options from the menu.
3. Select the Programs tab.
4. Select your desired email client from the drop down list.
5. Click Ok.
6. To test your selection, click [this link](#) to see if it opens your desired email client.

In Windows Vista, 7, and 8:

1. Click Start.
2. Type “default programs” in the Start Search box.
3. Click Default Programs under Programs in the search results.
4. Click Set your default programs.
5. Highlight your desired email client on the left.
6. Click Set this program as default.
7. Click Ok.
8. To test your selection, click [this link](#) to see if it opens your desired email client.

In Windows 10:

1. Click on the Start menu button - lower left.
2. Click on the Settings menu item.
3. Click on the System icon.
4. Click on the Default Apps menu item.
5. Look for the Email heading, and click on the current default email client just below the heading.
6. Select your desired email client.
7. Close the Settings window.
8. To test your selection, click [this link](#) to see if it opens your desired email client.

Notes:
- The email addresses used for the reminders come from the "Email" field on the personnel form.
- You may need to restart Training Manager after making the changes to your default email client.

Troubleshooting

Problem:
I want to use Gmail for the email client, but it is not listed in the options for default email client.

Solution:
If Gmail is not listed as an option for a default email client in your version of Windows, you will need to
install a 3rd party utility which can be set as the default and configured to send via email. Here is a link to a utility which provides that feature: Affixa

Problem:
When sending an email to a list of email addresses, a message indicates that the email addresses should be separated by semi-colons instead of commas. Note however, that a comma is designated to be used to separate email addresses in RFC Section 3.4 for Internet Message Format.

Solution:
Microsoft has acknowledged a bug for this issue in Outlook 2003 and Outlook 2007. Per their support page: "Status: Microsoft has confirmed that this is a problem in the Microsoft products that are listed at the beginning of this article." Microsoft has also provided the following solution:

Follow these steps to configure Outlook to recognize the comma as a valid e-mail address separator:

1. On the Tools menu, click Options.
2. Click E-Mail Options, and then click Advanced E-Mail Options.
3. Under When sending a message, click to select the Allow comma as address separator check box.

Note You can still use a semi-colon (;) to separate e-mail addresses when you click to select the Allow comma as address separator check box.

See the following Microsoft support article for the full details: http://support.microsoft.com/kb/820868

Problem:
When sending an email, the following message appears: "Either there is no default mail client or the current mail client cannot fulfill the messaging request".

Solution:
Set the default email client as described at the top of this page.

If the default email client has already been set, but the problem continues, the Outlook registry key may be corrupt. See the following article from Microsoft for solution details: http://support.microsoft.com/kb/813745

If the above solutions do not resolve the problem, check to see if the version of Outlook installed is 64 bit. There is no benefit in using the 64 bit version of Outlook, and it is not compatible with many applications. See this article for more information: http://www.msoutlook.info/question/461

4.10 Advanced Configuration

Select a topic below:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- ODBC Connections
4.10.1 Command Line Options

**Client software command line options:**

/\server [Server Name Or IP Address]
Specify the server name or ip address of the server where the Asset Manager database is running.
Default: previously used server name.

/\alias [Name of database alias]
Specify the name of the database alias to connect to.
Default: previously used alias name.

/\userprofile [roaming]
Specify "roaming" to use a Roaming profile for User.config settings.
Default: Local User.config settings.

You may create a shortcut on the desktop, and then edit the shortcut properties to modify the target to include the parameters at the end.

Example Usage:
"C:\Program Files\Asset Manager 2016 Enterprise\AssetManager.exe" /server localhost /alias AssetManager /userprofile roaming

**Installation (setup file) command line parameters:**

Options for the setup file can be set for unattended installations. For a complete list of setup command line parameters, please see the following link:

[Setup command line parameters](#)

4.10.2 Citrix/Terminal Server Configuration

If you have installed the client software on a Citrix/Terminal Server, you will need to manually configure the default database connection settings for new users. New user profiles will then use the database connection setting that you define rather than the default local file-based database connection. A server-based connection is required in order to have more than one user logged into the client at the same time. There are two options available for setting a default database server to connect to:

**Option 1: Set command line options in the user's shortcut.**

For details, please see the [Command Line Options](#) section in this User Guide.

**Option 2: Update the AssetManager.exe.config file to specify the default value for new windows profiles.**

On the Terminal Server:

1) First, make a backup copy of the AssetManager.exe.config file which is located in the C:\Program Files\[Program Name] directory.
2) Next, open the [Program Name].exe.config file in Notepad, and make the changes as shown below. Copy the “New Values” sections and then paste it over the similar section in your config file to make sure it is exact. If the Firebird database is on a different server, replace "localhost" with the name of the server which hosts the Firebird database.

OLD VALUES:

<setting name="DBType" serializeAs="String">
   <value>FirebirdEmbedded</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
   <value /></setting>

NEW VALUES:

<setting name="DBType" serializeAs="String">
   <value>FirebirdServer</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
   <value>localhost</value>
</setting>

3) Save the changes and open the client to confirm the settings are correct.

Note: If you have already logged in with some other user accounts, make sure those profiles have the matching database settings set using the menu option Tools --> Database Connection (while logged in with the existing user account). The configuration above will set the default for all NEW profiles created (profiles are created the first time a user opens the application while logged on to the machine with their windows account).

You may also test your updates as follows:
After making the changes to the program config file as shown above,
Delete the user.config file in the local user application data directory (see File Locations).
Open the application. It will load the application configuration and re-create the user.config file.

If the application displays an error message after making the changes, restore the backup of the program config file. If you do not have a backup of the program config file, delete it and then reinstall the application to restore the default version.

Troubleshooting Errors in Citrix
In some cases, when opening the software running on Citrix, an exception will occur with the message system.nullreferenceexception, and the screen may be blank or contain a large red 'X'. This can happen due to Windows not having a primary screen defined.

Conditions for not having a primary screen defined on Citrix server:

- Having a Citrix client using dual screen with primary screen set on the right,
- Having a cumulated resolution X colorDepth of client dual screen higher than the maximum video memory allowed on Citrix server per client.
Solutions for this problem include:

- In the display properties, change the primary screen to the one on the left.
- In the display properties, change the resolution to a lower value.

Note: You may need to close the Citrix session and login again after changing these values for the change to take place properly.

4.10.3 File Locations

Below is a listing of default file locations for Config, Database, and Log files for our software products. This information may be useful for special configurations or when diagnosing a connection error. In most cases you will not need to modify these files. If you decide to modify any of the files listed below, create a backup copy of the original file before changing it.

### Config Files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].exe.config</td>
<td>Program Files[Program Name]</td>
<td>This file contains the default values that will be used to create the initial user.config file which in turn is used to store individual user preferences.</td>
</tr>
<tr>
<td>user.config</td>
<td>Local Users Application Data folder*</td>
<td>This file is created the first time a specific user opens the program, and it is updated as preferences are changed.</td>
</tr>
<tr>
<td>aliases.conf</td>
<td>Program Files\Firebird (on the server)</td>
<td>This file is used by the Firebird server process to lookup the physical location of the database file.</td>
</tr>
</tbody>
</table>

### Database Files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].adb</td>
<td>All Users Application Data folder* (on the client)</td>
<td>This is the raw Firebird database file used by the embedded client.</td>
</tr>
<tr>
<td>[Program Name].adb</td>
<td>C:\KZSoftware[Program Name].adb (on the server)</td>
<td>This is the raw Firebird database file used by the Firebird server process.</td>
</tr>
</tbody>
</table>

### Log Files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log.txt</td>
<td>All Users Application Data folder* (on the client)</td>
<td>This file contains the log of any application errors that occur on the client.</td>
</tr>
<tr>
<td>firebird.log</td>
<td>C:\Program Files\Firebird\firebird.</td>
<td>This file contains the log of any errors related to Firebird.</td>
</tr>
</tbody>
</table>
**System Defined Folders**

**Local Users Application Data Folder:**
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\[user account name]\Local Settings\Application Data\Kaizen_Software_Solutions\[Unique Program ID]
- Windows Vista, 7, 8, and 10: C:\Users\[user account name]\AppData\Local\Kaizen_Software_Solutions\[Unique Program ID]

You may also find this folder by typing %USERPROFILE% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, 8, and 10) and then drilling down into the appropriate folder.

**All Users Application Data Folder:**
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\All Users\Application Data\[Program Name]\[database file]
- Windows Vista, 7, 8, and 10: C:\Program Data\[Program Name]\[database file]

You may also find this folder by typing %AllUsersProfile% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, 8, and 10) and then drilling down into the appropriate folder.

These folder locations are hidden by default, so you may need to show all files and folders in order to find them (My Computer --> Tools --> Folder Options --> View tab --> Show all files and folders).

### 4.10.4 Change the port number

The default Firebird configuration listens for incoming connections on port 3050. If you are running only once instance of Firebird, then no changes are required. However, if you have multiple instances of Firebird running on one machine, then each one must listen on a different port. You can change the port that a given instance uses by modifying the firebird.conf file which is located in the Firebird directory for that instance.

**Important Note:** The information in this section is provided for advanced configuration only. In most cases, only one instance is required so the default port setting can be used and none of the changes listed in this section are needed.

### Set the port which Firebird uses

To change the port from 3050 to 3051, open the file C:\Program Files\Firebird\KZFirebird\Firebird.conf in Notepad, and locate the line containing "RemoteServicePort". Then modify the setting as follows:

OLD: #RemoteServicePort = 3050
NEW: RemoteServicePort = 3051

*(Remove the # sign and change the port number to 3051)*

After changing the port and saving the changes. Stop the Firebird service and then Start it again.

### Connect using the new port

After changing the port number that the database listens on, you will need to update the port number in the client application.
that the client software connects to as follows:

1. Select the menu option Tools --> Database Connection.
2. Select the "Advanced" tab.
3. Uncheck the "Default" checkbox and set the Port to the new value.

### 4.10.5 Multiple Databases Per Server

[Enterprise Edition]: A database server can be configured to host multiple completely separate databases which can be identified with a unique name (Alias). You can choose which database to connect to by entering the name of the alias on the Advanced tab of the database connection form, or by setting up separate shortcuts for each database. See below for details:

**Setting up the server:**

1. First, install the Firebird database software and configure it for use with a single database as described in the shared database configuration instructions (if you haven't already).
2. After successfully installing, configuring, and testing the shared database, close all connections to the database and then make a copy of the database file located in the directory C:\KZSoftware. Name this file to distinguish it from the other files as needed. For example, if this is a test database, you may name it: AssetManagerTest.adb.
3. Lastly, use notepad to open the file "aliases.conf" (located in the Program Files \ Firebird directory), and add a new line containing the path to the new database file you created in Step 2, and an "Alias" name you will use to refer to this connection. Use the same format as the existing entries in the file. You may copy an existing entry and then paste it in at the bottom of the file and make changes to the alias name and database file path as needed. Be sure each database file has a unique alias name. In keeping with the "Test" database example, you might name the new alias, "AssetManagerTest".

At this point, you should have already connected to the default alias from the client, and you can test the connection to the new alias as follows:

**Connection to the new alias:**

1. Open the client software, and select the menu item Tools --> Database Connection.
2. Select the "Advanced" tab, and change the "DB Name (Alias)" field to the name of the new Alias you created in Step 3 of the server setup.
3. You can now test the connection and then save it.

You can also set up multiple shortcuts to open the client with the specified database alias selected. For more information, please see the Command Line Options in the user guide at the following link:

[Command Line Options]

### 4.10.6 Multiple Firebird Instances

The Firebird database server supports the option to run multiple instances on one machine. Each instance can be given a name and run as a Windows Service. This may be needed if you have other applications which require you to run a different version of Firebird on your server.

The KZFirebirdServer installer has been updated to install a named instance as follows:
Instance Name: "KZFirebirdInstance"
Directory: C:\Program Files\Firebird\KZFirebird

It will appear in the list of Windows Services with the name, "Firebird Server - KZFirebirdInstance".

If additional Firebird instances are installed, you will see the services listed with different names. A default Firebird installation which has not been given an instance name will appear with the name "Firebird Server - DefaultInstance".

To run multiple instances of Firebird, each instance must be configured to listen on a different port. For details, see the topic: Change the port number.

4.10.7 ODBC Connections

**ODBC Connection to Firebird Database**

You may connect to Firebird databases using an ODBC Connection. This allows you to connect 3rd party database utilities (such as MS Access or Crystal Reports) directly to the database.

**Important Notes:**

- Perform read-only operations only, and make a backup of your database before attempting any direct database connections.
- Do not change the database schema or add new database views based on existing views. Future software updates may fail if a database view contains unexpected dependencies from a custom user-created database view.

An ODBC driver is available at the following links:
After installing a Firebird ODBC Driver, follow the steps below to create an ODBC connection.

**Create an ODBC Connection in Windows**

**Step 1: Add a new data source using the Firebird driver in the Windows ODBC Data Source Administrator.**

![ODBC Data Source Administrator](image)

This control panel applet is available in Windows Administrative Tools.

**Step 2: Select your data source and then click the Configure button to configure the settings:**
Example Connection to a remote Training Manager database. For Asset Manager or Vehicle Manager, replace "Training" with "Asset" or "Vehicle".

Settings:

- **Database:**
  - For a local file database, select the database file (e.g. TrainingManager.tdb, VehicleData.vdb, or AssetManager.adb). In the file browser window, select "All Files" to remove the *.fdb filter from the file selection box.
  - For a remote database, enter the name of the server and the name of the database alias separated by a colon (no spaces).
- **Client:** Enter path to fbclient.dll. The fbclient.dll file can be found in the installation folder / odbc directory, or it can be downloaded here (FBClient2.1.7). Be sure to match the "bitness" (32 bit or 64 bit client).
- **Database Account:** SYSDBA
- **Password:** masterkey
- **Role:** [leave blank]
- **Extended Identifier properties:** quoted identifiers
- **Character Set:** UTF8
- **Dialect:** 3

**Firebird ODBC Connection Troubleshooting**

**Problem:** Cannot open database
**Solution**: Match 32 bit or 64 bit for all components:

1. ODBC Driver
2. ODBC Admin program
3. fbclient
4. Any 3rd party utilities such as MS Access, Crystal Reports, etc.

It gets confusing on 64 bit Windows 7 because there are two versions of the ODBC admin program. Oddly, the 32 bit version is stored in the SysWOW64 directory, while the 64 bit version is stored in the System32 directory:

- The 32-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\SysWoW64 folder.
- The 64-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\System32 folder.

**Problem**: “Tables not found” message in Crystal Reports.

**Solution**: Set the "Overridden Qualified Table Name" in the Properties for each table in the Crystal Reports set database dialog. Note that table names are case sensitive.

---

5  **How To (Steps)**

- Check-Out assets
- Check-In assets
- Perform An Asset Audit/Physical Inventory
- Add Company Name and Logo to Reports
- Export a report
- Manage the system (technical)

Additional details about individual areas of the software can be found in the Reference section.

5.1  **Check-Out assets**

There are different options available for checking out an asset, depending on your needs. After completing the check out process, the "Checked Out To" (Custodian) field and the Due Date field will be updated, and a new entry will be added to the Asset History tab.

**Screencast: Check Out An Asset**

**Option 1: Check-out one asset**

1. With Asset Manager open, **scan the asset barcode** on the item to be checked out in order to locate and open the asset form for that item.
2. With the Asset form open, **press the F3 key** on your keyboard, or click the "Check Out" button located near the top of the form to open the Check-out window.
3. With the cursor in the "Scan Badge" area, scan the employee badge, or select the person for the item
to be checked out to.
4. Set the Due Date, Status and Location values, enter a Comment if required, and check the "Print Check-out receipt" checkbox if you would like to print a receipt for the transaction.
5. Click the "Complete Check Out" button to complete the check out process.

*If the item does not contain a barcode or cannot be found by scanning the barcode, select "All Types" in the folder hierarchy on the left, and then enter the barcode number or a few characters of the description in the Quick Search box located near the upper right part of the list view to locate the item, and then open the asset form.

**Option 2: Check-out several assets to an individual**

Assets may be checked out one at a time as described in Option 1, or you may check out several assets to an individual at once as described below:

1. With Asset Manager open, **scan the employee badge** or use the Quick Search option on the Personnel tab to locate and then open the Personnel form for the employee who is checking out the items.
2. With the Personnel Form open, press the F3 key on your keyboard, or click the "Check Out" button on the "Assets Checked Out" tab to open the Check-out window.
3. With the cursor in the "Search" box, begin scanning asset barcodes for the items to check out, or perform a search to add them to the check out list.
4. Set the Due Date, Status and Location values, enter a Comment if required, and check the "Print Check-out receipt" checkbox if you would like to print a receipt for the transaction.
5. Click the "Complete Check Out" button to complete the check out process.

### 5.2 Check-In assets

There are several options available for checking in an asset, depending on your needs. After completing the check in process, the "Checked Out To" (Custodian) field and the Due Date field will be cleared, and a new entry will be added to the Asset History tab.

**Option 1: Check-in one asset**

1. With Asset Manager open, **scan the asset barcode** on the item being returned in order to locate and open the asset form for that item.
2. With the Asset form open, **press the F3 key** on your keyboard, or click the "Check In" button located near the top of the form to open the Check-In window.
3. Set the new Status and Location values, enter a Comment if required, and check the "Print check-in receipt" checkbox if you would like to print a receipt for the transaction.
4. Click the "Complete Check In" button to complete the check in process.

*If the item does not contain a barcode or cannot be found by scanning the barcode, select "All Types" in the folder hierarchy on the left, and then enter the barcode number or a few characters of the description in the Quick Search box located near the upper right part of the list view to locate the item, and then open the asset form.

**Option 2: Check-in several assets from one individual**

Assets may be checked in one at a time as described in Option 1, or you may check in several assets from an individual at once as described below:
1. With Asset Manager open, **scan the employee badge** or use the Quick Search option on the Personnel tab to locate and then open the Personnel form for the employee who is returning the items.

2. On the "Assets Checked Out" tab of the personnel form, select the assets* to be checked in, and then click the "Check In" button to open the Check-In window.

3. Set the new Status and Location values, enter a Comment if required, and check the "Print check-in receipt" checkbox if you would like to print a receipt for the transaction.

4. Click the **Complete Check In** button to complete the check in process.

*To select multiple assets in the list:
- Hold down the ctrl key on your keyboard while clicking on rows - OR -
- Select a row and then press the letter 'a' while holding down the ctrl key - OR -
- Select the first row in the list and then select the last row while holding down the shift key.

**Option 3: Check-in several assets from different individuals**

1. With Asset Manager open, **scan the asset barcode** on the first item being returned, or locate the asset form as described in Option 1, and open it.

2. With the Asset Form open, **press the F3 key on your keyboard**, or click the "Check In" button located near the top of the form to open the Check-In window.

3. With the cursor in the **Search box** on the Check-In window, continue adding items to the check-in list by scanning the barcodes or performing a search for the item. Repeat until all assets have been added to the check-in list.

4. Set the new Status and Location values, enter a Comment if required, and check the "Print check-in receipt" checkbox if you would like to print a receipt for the transaction.

5. Click the **Complete Check In** button to complete the check in process for all items at once.

**5.3 Perform An Asset Audit/Physical Inventory**

The Asset "Audit" dialog box allows you to paste in a list of barcode numbers to add audit records to all of the found assets at once. This feature improves the stocktaking/physical inventory procedure by allowing you to capture barcodes with a mobile barcode reader while walking around scanning the asset barcodes in an area, and then return to your computer to update the audit status for all items at once without the manual lookup for each item.
Here is how the Asset Audit (Stock-Taking) process works:

1. Enter or upload the asset list for your organization.
2. After walking around with a mobile barcode reader scanning the assets in your organization, return to your computer, and export the list of barcodes to a text file with one barcode number per line.
3. Select the list of barcode numbers, and then copy them to your clipboard.
4. Open the Audit form by clicking the Audit button in the Asset list toolbar, and then paste the barcode numbers in the area provided by right-clicking and then selecting “Paste”, or by pressing the key combination ctrl + v. Add any notes as needed, and then click the Add Record button to add the record(s).
5. The asset audit report can then be used to locate any missing assets by setting the filter to show assets that have not been audited in the past X days (you can set the value to any number of days as needed).

If you do not have a mobile barcode reader, you may use the method of printing the overdue audit report (see sample below) and then checking off items as you physically confirm their presence, and then look them up to add individual audit records. Alternatively, you may open the Audit form and then enter the barcode numbers (one per line). Or, if you have a wired barcode reader hooked up to a wireless laptop, you may place the cursor in the text area on the audit form, and scan each barcode from the checklist to add it to the list.
5.4 Add Company Name and Logo to Reports

You can customize the report headers to include your company name and logo.

**Screencast: How to set Company Options**

To list your company name and logo on reports:

1. Select the main "Reports" tab.
2. Click on the "Options" button in the toolbar located just above the report.
3. "Edit" the Custom Header/Footer to use your company name.
4. Make sure the checkbox is checked to include the Company Logo.
5. Select a logo on the Company Logo tab.

5.5 Export a report

Reports may be previewed and printed on the main Reports tab. Additional options including the option to export the report to another format are also available. This can be helpful if you would like to distribute the report outside of the Asset Manager system. There are several export formats available. PDF Format is a popular choice to retain the formatting, and allow others to open the report with the free Adobe Acrobat Reader software.

Here are the steps to export a report:

1. Select the report to export on the main Report tab, and set the filter options as needed.
2. Click the "Open in new window" button located in the toolbar just above the report selection area.
3. In the new report window which opens, select the menu option File --> Export.
4. Set any options as needed, and then click Ok to select a location to save the report.
5. Click "Save" to save the report to the location you have selected.

5.6 Manage the system (technical)

Asset Manager is designed to run with minimal system administration. However, there may be a time when you need to move the database, upgrade the software, set up scheduled database backups, or perform other non-routine system related activities which require additional technical information. Many of the common activities can be found in the System Administration section of this user guide. If you are unable to find what you need there, or need some additional help with one of the items, you may contact
us at anytime through the Support options on our website.

6 Getting More Help

This User Guide provides commonly needed documentation for using Asset Manager and can often help resolve questions very quickly. Be sure to check out the reference section for detailed information about specific areas of the program.

Technical Support and Customer Service is also available via email. You may contact us for additional help using the links below:

Contact Us

For Technical Support:
http://www.kzsoftware.com/support/index.htm

For Customer Service:
http://www.kzsoftware.com/contact/index.htm

Reach us by mail at:
Kaizen Software Solutions, LLC
39962 Cedar Blvd. Ste. 323
Newark, CA 94560-5326

7 How To Buy

You may purchase Asset Manager online worldwide with any major credit card. Additional purchasing options including Phone, Purchase Orders, Bank Transfers, and Checks are also available through our reseller.

As soon as your transaction is complete, your license key will be emailed to you, and you can enter the license key to continue working where you left off.

Purchasing Links

Direct Order:
http://www.kzsoftware.com/purchase/asset_management/

Additional Purchasing Options
http://www.kzsoftware.com/purchase/options.htm